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Chapter 1: Getting Started
The MicroMax GPS300, GPS350, and GPS360 interrupters are programmable, GPS-synchronized, 
current interrupters. The information in this guide is intended for authorized service personnel who 
plan to install and program an interrupter for service. 

This section includes the following topics:

 l Interrupter Overview on page 1

 l Supplied Power Cables and GPS Antenna on page 4

 l Required Tools and Equipment on page 6

 l Optional Hardware and Software  on page 6

 l Contacting Technical Services  on page 7

Interrupter Overview
The MicroMax GPS300, GPS350, and GPS360 interrupters are fully programmable, satellite-
synchronized interrupters that are capable of interrupting rectifier, bond, or any other current. Cycles 
can be programmed using any combination of time intervals between 0.1 seconds and 999.9 
seconds (in 0.1 second increments) for "Off" and "On" cycles. The interrupters can store up to 9 
interruption programs for later use.     

Figure 1-1.   MicroMax Interrupters     

The MicroMax GPS350 and GPS360 also include a built-in solid state relay (normally closed) that can 
interrupt either AC or DC, up to 60 A with on/off cycles of less than 4 seconds and 80 A with cycles 
totaling 4 seconds or longer. The relay can be easily installed without concern for polarity. The 
GPS360 includes a battery for use without an external power source.     
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Output parameters are set to accommodate any external relay configuration. Additionally, the menu-
driven synchronization configuration allows the interrupter to operate with almost any other brand 
of GPS synchronized interrupter or data logger. Based on the number of satellites seen and the 
quality of view, synchronization triggering accuracy is specified to within 1µs with any other 
MicroMax interrupter.     

A unique patent-pending Interference Mode interruption cycle allows rectifier influence studies with 
greatly increased productivity and ease of data interpretation. By operating in interference mode, it 
is possible to determine the influence from each individual rectifier being interrupted and get the 
instant "Off" and "On" pipe-to-soil potentials, all during a single visit to a test station. The influence 
from up to 99 rectifiers can be studied simultaneously using Interference Mode.     

Figure 1-2.   Interference Mode Example 

The MicroMax interrupters also allow for full cathodic protection (CP) polarization when the 
interrupter is not in use (rectifier "on" and no interruption).        

Relay and Interruption Features
The GPS300, GPS350, and GPS360 interrupters can be connected to almost any external current relay 
(or multiple relays) using a 12V control. Depending on the configuration, the interrupter supplies up 
to 500mA (12V) relay control current. As a result, numerous relays can be controlled with one 
interrupter. This leads to significant cost savings in areas where multiple current sources in a 
confined area need to be switched. The MicroMax interrupters can be set to accommodate normally 
open and normally closed relays. There are several relay options for switching either AC or DC at 
various loads. 

The GPS350 and GPS360 include a built-in solid state relay that can interrupt either AC or DC, up to 
60 A with on/off cycles of less than 4 seconds and 80 A with cycles totaling 4 seconds or longer. The 
internal relay can be easily installed without concern for polarity. 

The  MicroMax interrupter relay and interruption features include:

 l The interrupters can drive an external relay of 100 A / 100 V (higher capacities available). 

 l The interrupters can be connected to any external current relay (or multiple relays). The 
interrupter supplies up to 500mA.         

 l GPS300 can be used with a solid state relay (AC or DC) or mercury relay (AC or DC).         
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NOTE: For important information about mercury relays, refer to Mercury Relay Advisory on 
page 61.       

 l GPS350 and GPS360 have a built-in solid state relay that can interrupt either AC or DC, up to 
60 A with on/off cycles of less than 4 seconds and 80 A with cycles totaling 4 seconds or 
longer. The relay is Normally Closed.         

 l The interrupters include the ability to use Zero Crossing to set when timed measurements are 
taken. Zero Crossing allows you to use the instant when the AC crosses zero instead of using a 
GPS reading.

 l With external relays, user-selectable control of the interrupters output to 0 V or 12 V for "On" 
or "Off." (Accommodates normally open or normally closed relays.) 

 l Synchronization can be set on the leading or falling edge of the interruption cycle.         

 l Interruption continues automatically after power is disrupted.         

 l Cycle range up to 999.9 seconds in 0.1 second increments.         

 l Synchronization triggering accuracy is within 1µs with any other GPS300or GPS350 interrupter 
and collectively is less than 5µs after the PPS signal (precise positioning service signal) as 
provided by the GPS satellite constellation, even when only one satellite is visible.         

 l The interrupters are fully programmable between the following schedules: continuous, daily, 
start/stop, and interference. Can store up to nine different interruption programs for later use.

Mounting and Power  Features
 l GPS350 and GPS360 are shipped with factory-installed mounting magnets that can be used to 

easily attach the interrupter to an available surface.         

 l GPS360 includes an internal, rechargeable battery. 

NOTE: Be sure to fully charge the battery before field use.         

 l Interrupters can be powered from either AC or DC, with a wide range of input voltages.         

Working with Other Brands of Interrupters
The MicroMax GPS300, GPS350, and GPS360 interrupters will work with most GPS-synchronized 
interrupters on the market. Most manufacturers use the same principle of calculating interruption 
synchronization.     
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Use the following procedure to synchronize a JR-2 interrupter with the MicroMax interrupters. The 
following procedure uses the optional, JR-2 adapter cable provided by AI.     

 1. Connect the JR-2 adapter cable to the JR-2 interrupter. Connect the other end of the adapter 
cable to the relay control output cable provided in the installation kit. Do not connect the 
banana plugs on the other end of the relay control output cable at this time.         

 2. Start the interrupter with the following output parameters and interruption settings:         

 l Switch: Normally Closed (Low output = Off)               

 l Int. Cycle: OFF/ON               

 l On = 59.5 Off = 0.5               

 3. After the  interrupter has started interruption, use the exact time of the interrupter as a guide 
when setting the JR-2 interrupter. Set the time ahead on the JR-2 interrupter to allow enough 
time to finish the procedure.         

 4. Before the next OFF cycle on the  interrupter, connect the banana plugs on the JR-2 adapter 
cable to the INPUT connections on the power / relay assembly cable. Wait until an OFF cycle 
has executed.         
The power cable assembly for the  interrupter is typically used for the relay control output 
cable.         

 5. The interrupters should now be synchronized (clocks are set at the exact same time), and the  
interrupter can be set back to the required program.         

Supplied Power Cables and GPS Antenna
The following cables are provided in the installation kit with the interrupters. The interrupters 
consume approximately 120 mA. External relay current consumption is additional, which is typically 
less than 10 mA for a solid state relay and as high as 400mA for a mechanical mercury relay.     

NOTE: Refer to the interrupter's installation chapter for instructions on how to connect the cables.       

 l Power Cable and AC/DC Power Input Cable with Alligator Clips
Specifications for the cables after assembly:         

 — INPUT: 8-42 V AC or 10-60 V DC.

 — OUTPUT: 10-14 V DC (500 mA maximum).
                Red indicates positive (+); black indicates negative (–).               
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Figure 1-1.   Power Cable and AC/DC Power Input Cable with Alligator Clips         

 l GPS Antenna: The GPS antenna should be mounted on a metal surface with a clear view of 
the sky.         

Figure 1-2.   GPS Antenna         

Below is an example of the connections located on the side of the GPS300.     
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Figure 1-3.   GPS300 Connections     

Below is an example of the connections located on the side of the GPS350 and GPS360.     

Figure 1-4.   GPS350 and GPS360 Connections and Relay Cables     

Required Tools and Equipment
The following tools and equipment are required for installing and configuring the unit for service:     

 l Voltmeter         

 l Hand tools for installing relay         

Optional Hardware and Software 
MicroMax GPS300, GPS350, and GPS360 interrupters can be programmed through the unit's 
keyboard (refer to Configuring with Unit Keypad on page 31). As an alternative method of 
programming the interrupter, you can also configure the unit with Bullhorn Tools configuration 
software using a Microsoft Windows-based computer with the following hardware and software 
specifications:     

 l Pentium processor or equivalent         

 l 2 GB RAM (minimum)         

 l 400 MB free hard drive space (minimum); 1 GB recommended         
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 l Spare USB port         

 l USB mini-b cable (standard mini USB cable typically used with most digital cameras)         

 l Microsoft Windows 7 Home Premium, Professional, or Ultimate or later versions         

 l Bullhorn Tools configuration software (available from Bullhorn Tools launch page)         

 l Windows Internet Explorer version 8.0 or higher         

 l Adobe Reader version 6.0 or higher (available from the Adobe website) 

Refer to Configuring with Bullhorn Tools on page 39 for details on configuring with this software. 

Contacting Technical Services 
AI Technical Support is available to provide assistance with your unit, accept feedback about units, 
or discuss your organization’s training needs. Use the following information to contact AI Technical 
Support:

Telephone:

1-800-229-3404

Email:

techservices@aiworldwide.com

Address:

American Innovations, Ltd.
Attn: AI Technical Support
12211 Technology Blvd.
Austin, TX 78727

http://install.bullhornsys.com/BullhornTools/
http://adobe.com/
mailto:techservices@aiworldwide.com?subject=AI Technical Support
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Chapter 2: GPS300 Installation
The GPS300 interrupter consumes approximately 120mA. Relay current consumption is additional, 
which is typically less than 10mA for a solid state relay and could be as high as 400mA for a 
mechanical mercury relay. 

The GPS300 installation process includes the following steps:

 l Installing the GPS300 Interrupter on page 8

 l Setting Display Contrast on page 12

 l Viewing GPS Info on page 12

 l Running a Test Program on page 13

Installing the GPS300 Interrupter
When completing the following procedure, refer to Supplied Power Cables and GPS Antenna on page 
4 for input and output voltage specifications.     

WARNING: Make sure to follow all precautions when working with the interrupter and high 
voltage circuits.       

WARNING: Do not connect the GPS300 to primary power.       

The installation process includes the following steps. Refer to the individual sections for each step 
for the complete instructions.     

 l Determining a Power Source on page 8

 l Connecting a Relay on page 9

 l Connecting the GPS Antenna on page 11

Determining a Power Source
Determine how to power the MicroMax interrupter using one of these possible sources:         
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 1. Rectifier - with power turned on to the rectifier, use a voltmeter to locate a power source 
across two available AC taps. The interrupter requires 8-42 V AC or 10-60 V DC.

 2. A 120 V AC convenience outlet to use with the 12 V DC wall adapter.               

 3. A DC source, such as a 10-60 V DC battery. 

Figure 2-1.   Power Source Options         

Connecting a Relay
The GPS300 requires an external relay to perform interruptions. The GPS300 can be used with an AC, 
DC, or mercury relay. Refer to Mercury Relay Advisory on page 61 if working with a mercury relay. 

 1. Turn OFF all power to the rectifier.         

 2. If a relay is not already installed, install an AC, DC, or mercury relay according to the relay's 
installation instructions.         

 3. Connect the GPS300 power cable to the GPS300 interrupter. Line up the notch on the cable to 
the connection on the interrupter. Twist ring on cable to lock the cable into the connection.         

Figure 2-1.   Power Cable and GPS300 Connection                 
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 4. Connect relay control or coil to the power cable OUTPUT. Be sure to observe proper polarity, 
especially if a flyback diode is present on a mercury relay coil.

Figure 2-2.   Power Cable Connections                 

 5. Connect the AC/DC Power Input cable to the power cable's INPUT connection.         

Figure 2-3.   AC/DC Power Input Cable Connected to Twisted Wire Cable         

 6. Clip the AC/DC Power Input cable's alligator clips to the rectifier Coarse AC taps. Voltage 
range is 8-42 V AC.         

Figure 2-4.   Alligator Clips Connected to Rectifier Taps         

If you are connecting to a DC power source such as a battery, the power requirement is 10-60 
V DC.         
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Connecting the GPS Antenna
 1. Connect the magnetic-mount, GPS antenna to the GPS connector on the GPS300.         

Figure 2-1.   GPS Antenna Connection         

 2. Mount the GPS antenna on a metal surface making sure the antenna has a clear view of the sky. 
If a metal surface is unavailable, glue a flat washer on a suitable surface and then place the GPS 
antenna on the flat washer.         
After applying power to the GPS300 interrupter, unit information briefly appears in the 
display.         
After the initialization process completes, the interrupter displays the main menu. If the main 
menu does not display (this may take several minutes), make sure the interrupter is not 
currently running another program. If another program is running, press PREV and then 
ENTER.         

 3. The main menu displays available menu options that you can select. To select a menu option, 
use the keypad to select the number associated with the menu option. For example, press 1 
on the keypad to select the Interrupt menu option.         
The main menu also displays current time and date and satellite information. For information 
on the symbols shown on the screens, see Status Icons on page 30.

Figure 2-2.   Main Menu         

Refer to Interrupter Programming on page 30 for more information on configuring the interrupter.     
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Setting Display Contrast
Use the up  and down  arrow keys on the keypad to adjust the contrast level of the display. 
Press and hold the up arrow to increase the contrast; press and hold the down arrow to decrease the 
contrast.     

You can adjust the contrast level at any time except when the interrupter is running an interruption 
program.     

Viewing GPS Info
The GPS Info screen includes status information for the current number of satellites in view, time 
zone, antenna, and the current time and date.     

Figure 2-1.   GPS Info     

To display the GPS Info screen, press 2 from the main menu. Press PREV to return to the main menu.
     

The following list describes the type of information shown on the GPS Info screen:     

 l 15:32:01 02/20/14 — The current time and date. The time is shown in military time (24 hours) 
and uses the HH:MM:SS format to represent hours, minutes, and seconds. The date is shown in 
MM/DD/YYYY format to represent the month, day, and year. The plug symbol  indicates that 
power is present.         

 l GPS Antenna OK — The antenna status. If the antenna is disconnected or loose, the status 
message Antenna OPEN displays. If the antenna is shorted, the status message Shorted 
displays.         

 l 3D Fix Sats 09/12 — Shows whether a 2D or 3D GPS lock has been obtained and the number 
of satellites seen by the unit. In this example, 09/12 refers to 9 satellites in view out of 12 
possible satellites. A 2D lock requires 3 satellites, while 3D lock requires at least 4 satellites. If 
the unit sees an insufficient number of satellites, move the antenna until at least a 2D lock 
(preferably a 3D lock) is achieved.         
If no satellites are seen, the message Acq Sat appears in the display on the left side. The 
message 3D Fix displays when the unit has established communication with at least four 
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satellites.         

 l Current UTC -06 — The Universal Time Constant (UTC) that is used by the GPS system.         

IMPORTANT: GPS lock is not needed for the GPS300 to operate. The internal clock updates as 
soon as the internal GPS locates satellites. For synchronized interruption or interference, make sure 
the antenna position enables at least a 2D lock.       

Running a Test Program
Before programming the interrupter, you can test the interrupter by running a test program.     

With the main menu displaying, press  to display and begin the Test Mode. Press PREV to cancel 
the test or when the test is done.     

Figure 2-1.   Test Mode     

The following list describes the type of information shown on the Test Mode screen and that is used 
for the test:     

 l TEST MODE ON/OFF/DONE — The cycle that the interruption is running during the test. The 
test runs through an off and on sequence for a few seconds. It will then display DONE when it 
completes the test. The plug symbol  indicates that power is present.         

 l Switch: Norm Open — Shows whether the relay is normally open or normally closed. The 
setting is determined by the Switch setting in Out Parameters (refer to  Output Parameters on 
page 36).         

 l Synch — Shows that synchronization begins with On. The setting is determined by the Int. 
Cycle setting in Out Parameters (refer to Output Parameters on page 36).         

 l CYCLE 1s ON, .5s OFF — The timing of the on and off cycle.         
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Chapter 3: GPS350 Installation
The GPS350 interrupter consumes approximately 120 mA. The built-in solid state relay current 
consumption is additional 100 V / 80 A max with > 4 s cycle or 100 V / 60 A max with 1 s-4 s cycle. 
The relay is normally closed.     

The interrupters are set to use Normally Closed relays by default. If you plan to use a Normally Open 
relay, configure the interrupter prior to installing it. 

The GPS350 installation process includes the following steps:

 l Installing the GPS350 Interrupter on page 14 

 l Setting Display Contrast on page 18 

 l Viewing GPS Info on page 18

 l Running a Test Program on page 19

Installing the GPS350 Interrupter
When completing the following procedure, refer to  Technical Specifications on page 57 for input and 
output voltage specifications.     

WARNING: Make sure to follow all precautions when working with the interrupter and high 
voltage circuits.       

WARNING: Do not connect the MicroMax GPS350 to primary mains power.       

Metal relay casing on the GPS350 will get hot. Allow 5 - 10 minutes after interruption stops before 
handling the unit.     

The installation process includes the following steps. Refer to the individual sections for each step 
for the complete instructions.     

 l Determining a Power Source on page 15

 l Connecting the Built-in Relay to a Rectifier on page 15 — or connect an external relay         

 l Connecting the GPS Antenna on page 17
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Determining a Power Source
Determine how to power the MicroMax interrupter using one of these possible sources:         

 1. Rectifier - with power turned on to the rectifier, use a voltmeter to locate a power source 
across two available AC taps. The interrupter requires 8-42 V AC or 10-60 V DC.

 2. A 120 V AC convenience outlet to use with the 12 V DC wall adapter.               

 3. A DC source, such as a 10-60 V DC battery. 

Figure 3-1.   Power Source Options         

Connecting the Built-in Relay to a Rectifier
The GPS350 includes a built-in relay. You can also connect the GPS350 to an external relay. Refer to 
Mercury Relay Advisory on page 61 if working with a mercury relay.     

 1. Turn OFF all power to the rectifier.         

 2. Connect the interrupter's relay cables to the rectifier, depending on what you will be 
interrupting.         
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Figure 3-1.   Relay Cables         

 3. If interrupting the AC power, remove the tap change bar from the taps and connect both of 
the interrupter's relay cables to the same tap settings that were connected by the change bar.         

 4. If interrupting the DC power:         

 a. Disconnect DC output cable.               

 b. Connect one of the interrupter's relay cables to the output.               

 c. Slide shrink wrap tube on to the other relay cable.               

 d. Connect the DC output cable to the interrupter's relay cable.               

 e. Wrap relay cables in shrink wrap to prevent shorting the equipment.               

Figure 3-2.   Relay and DC Output Cable in Shrink Wrap               
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Connecting the GPS Antenna
 1. Connect the magnetic-mount, GPS antenna to the GPS connector on the interrupter.         

Figure 3-1.   GPS Antenna Connection         

 2. Mount the GPS antenna on a metal surface making sure the antenna has a clear view of the sky. 
If a metal surface is unavailable, glue a flat washer on a suitable surface and then place the GPS 
antenna on the flat washer.         
After applying power to the interrupter, unit information briefly appears in the display.         

 3. After the initialization process completes, the interrupter displays the main menu. If the main 
menu does not display, make sure the interrupter is not currently running another program. If 
another program is running, press PREV and then ENTER.         
The main menu displays available menu options that you can select. To select a menu option, 
use the keypad to select the number associated with the menu option. For example, press 1 
on the keypad to select the Interrupt menu option.         
The main menu also displays current time and date and satellite information. For information 
on the symbols shown on the screens, refer to Status Icons on page 30.
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Figure 3-2.   Main Menu         

Refer to Interrupter Programming on page 30 for more information on configuring the interrupter.     

Setting Display Contrast
Use the up  and down  arrow keys on the keypad to adjust the contrast level of the display. 
Press and hold the up arrow to increase the contrast; press and hold the down arrow to decrease the 
contrast.     

You can adjust the contrast level at any time except when the interrupter is running an interruption 
program.     

Viewing GPS Info
The GPS Info screen includes status information for the current number of satellites in view, time 
zone, antenna, and the current time and date.     

With the main menu displaying, press 2 to display the GPS Info screen. Press PREV to return to the 
main menu.     

Figure 3-1.   GPS Info     

The following list describes the type of information shown on the GPS Info screen:     

 l 15:32:01 02/20/14 — The current time and date. The time is shown in military time (24 hours) 
and uses the HH:MM:SS format to represent hours, minutes, and seconds. The date is shown in 
MM/DD/YYYY format to represent the month, day, and year. The plug symbol  indicates that 
power is present.         

 l GPS Antenna OK — The antenna status. If the antenna is disconnected or loose, the status 
message Antenna OPEN displays. If the antenna is shorted, the status message Shorted 
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displays.         

 l 3D Fix Sats 09/12 — Shows whether a 2D or 3D GPS lock has been obtained and the number 
of satellites seen by the unit. In this example, 09/12 refers to 9 satellites in view out of 12 
possible satellites. A 2D lock requires 3 satellites, while 3D lock requires at least 4 satellites. If 
the unit sees an insufficient number of satellites, move the antenna until at least a 2D lock 
(preferably a 3D lock) is achieved.         
If no satellites are found, the message Acq Sat appears in the display on the left side. The 
message 3D Fix displays when the unit has established communication with at least four 
satellites.         

 l Current UTC -06 — The Universal Time Constant (UTC) that is used by the GPS system.         

IMPORTANT: GPS lock is not needed for the GPS350 to operate. The internal clock updates as 
soon as the internal GPS locates satellites. For synchronized interruption or interference, make sure 
the antenna position enables at least a 2D lock.       

Running a Test Program
Before programming the interrupter, you can test the interrupter by running a test program.     

With the main menu displaying, press  to display and begin the Test Mode. Press PREV to cancel 
the test or when the test is done.     

Figure 3-1.   Test Mode     

The following list describes the type of information shown on the Test Mode screen and that is used 
for the test:     

 l TEST MODE ON/OFF/DONE — The cycle that the interruption is running during the test. The 
test runs through an off and on sequence for a few seconds. It will then display DONE when it 
completes the test. The plug symbol  indicates that power is present.         

 l Switch: Norm Open — Shows whether the relay is normally open or normally closed. The 
setting is determined by the Switch setting in Out Parameters (refer to  Output Parameters on 
page 36).         

 l Synch — Shows that synchronization begins with On. The setting is determined by the Int. 



Interrupters User Guide

Chapter 3: GPS350 Installation 20

Cycle setting in Out Parameters (refer to Output Parameters on page 36).         

 l CYCLE 1s ON, .5s OFF — The timing of the on and off cycle.         
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Chapter 4: GPS360 Installation
The GPS360 interrupter consumes approximately 120 mA. The built-in solid state relay current 
consumption is additional 100 V / 80 A max with > 4 s cycle or 100 V / 60 A max with 1 s-4 s cycle. 
The relay is normally closed.     

The GPS360 includes a built-in battery that is used to power the unit if an external power source is 
unavailable.     

The interrupters are set to use Normally Closed relays by default. If you plan to use a Normally Open 
relay, configure the interrupter prior to installing it. 

The GPS360 installation process includes the following steps:

 l Installing the GPS360 Interrupter on page 21 

 l Setting Display Contrast on page 27 

 l Viewing GPS Info on page 28

 l Running a Test Program on page 29

Installing the GPS360 Interrupter
When completing the following procedure, refer to Technical Specifications on page 57 for input and 
output voltage specifications.     

WARNING: Make sure to follow all precautions when working with the interrupter and high 
voltage circuits.       

WARNING: Do not connect the GPS360 to primary mains power.       

Metal relay casing on the GPS360 will get hot. Allow 5 - 10 minutes after interruption stops before 
handling the unit.     

The installation process includes the following steps. Refer to the individual sections for each step 
for the complete instructions.     
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 l GPS360 Power and Battery Information on page 22

 l Determining a Power Source on page 22

 l Connecting the  Built-in Relay to a Rectifier on page 23

 l Connecting the GPS Antenna on page 24

 l Optional — Connecting an External Relay with Line Power on page 26

GPS360 Power and Battery Information
The GPS360 includes a battery to power the interrupter as a stand-alone device. The following are 
considerations when powering the GPS360 with the battery:     

 1. Fully charge the battery before using. Refer to Status Icons on page 30  for charging and battery 
icons and descriptions.         

 2. On power up, the unit will stay on as long as it takes to acquire a GPS signal. Once it acquires a 
3D fix, it takes approximately two minutes to synchronize to GPS time and automatically enter 
the main menu or a previously loaded interruption program.         

 a. The unit will not go to sleep while in this mode, which could potentially drain the 
battery. The unit must get a GPS lock to enable power save features. You can bypass the 
GPS screen by pressing PREV.               

 3. The unit will turn off the LCD screen (power save mode) 30 seconds after the last key press. If 
an interruption program was not selected to run, the unit will enter deep sleep mode 5 
minutes after the last key press.         

 4. While an interruption program is running, the unit will enter power save mode but continue to 
interrupt. You can press any key at any time to check the status of the interruption program.         

 a. When using start/stop or daily interruption modes, the unit will go into deep sleep 
during non-interruption hours. Press any key to "wake up" the unit.               

 b. If you wake a unit from power save mode during interruption, it takes two minutes for 
the GPS to resynchronize. The unit will continue interrupting during resynchronization.               

 5. To put the unit in deep sleep mode, press and hold the PREV key until the screen flashes 
(approximately 10 seconds) and then release the key.         

Determining a Power Source
The GPS360 includes a built-in rechargeable lithium battery and relay. The battery can be used to 
complete up to 60 hours of interruption without re-charging. However, it is recommended that you 
use line power with the GPS360, if it is available, to preserve battery power.     
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Determine how to power the MicroMax interrupter using one of these possible sources:         

 1. Internal battery.

 2. Rectifier - with power turned on to the rectifier, use a voltmeter to locate a power source 
across two available AC taps. The interrupter requires 8-42 V AC or 10-60 V DC.

 3. A 120 V AC convenience outlet to use with the 12 V DC wall adapter.               

 4. A DC source, such as a 10-60 V DC battery. 

 5. A USB cable connected to a computer.

Figure 4-1.   Power Source Options         

NOTE: If available, use line power to power the GPS360 to save the internal battery power.    

Connecting the  Built-in Relay to a Rectifier
The GPS360 includes a built-in relay. You can also connect the GPS360 to an external relay. Refer to 
Mercury Relay Advisory on page 61 if working with a mercury relay.     

NOTE: If you will be installing the GPS360 on a bond, the relay wires must be connected in series 
with the two structure wires, one from each of the pipelines.       

 1. Turn OFF all power to the rectifier.         

 2. Connect the interrupter's relay cables to the rectifier, depending on what you will be 
interrupting.         
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Figure 4-1.   Relay Cables         

 3. If interrupting the AC power, remove the tap change bar from the taps and connect both of 
the interrupter's relay cables to the same tap settings that were connected by the change bar.         

 4. If interrupting the DC power:         

 a. Disconnect DC output cable.               

 b. Connect one of the interrupter's relay cables to the output.               

 c. Slide shrink wrap tube on to the other relay cable.               

 d. Connect the DC output cable to the interrupter's relay cable.               

 e. Wrap relay cables in shrink wrap to prevent shorting the equipment.               

Figure 4-2.   Relay and DC Output Cable in Shrink Wrap               

Connecting the GPS Antenna
After connecting the antenna, ensure that it has a clear view of the sky to get optimum connection 
to the satellites.     
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 1. Connect the magnetic-mount, GPS antenna to the GPS antenna connection on the interrupter.         

Figure 4-1.   GPS360 GPS Antenna Connection         

 2. Mount the GPS antenna on a metal surface, making sure the antenna has a clear view of the 
sky. If a metal surface is unavailable, glue a flat washer on a suitable surface and then place the 
GPS antenna on the flat washer.         
After applying power to the interrupter, unit information briefly appears in the display.         

 3. After the initialization process completes, the interrupter displays the main menu. If the main 
menu does not display, make sure the interrupter is not currently running another program. If 
another program is running, press PREV and then ENTER.         
The main menu displays available menu options that you can select. To select a menu option, 
use the keypad to select the number associated with the menu option. For example, press 1 
on the keypad to select the Interrupt menu option.         

Figure 4-2.   Main Menu         

The main menu also displays current time and date and satellite information. For information 
on the symbols shown on the screens, refer to Status Icons on page 30.
While the GPS360 battery is charging, a  displays in the top right corner. When the unit is 
fully charged, the icon is replaced by a full battery icon. As the battery power decreases, the 
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icon changes to reflect the power level of the battery. Also, as long as the interrupter is 
attached to an alternate power sources, such as a USB connection to a computer, the plug icon 

 will display.         

Refer to Interrupter Programming on page 30 for more information on configuring the GPS360.     

Connecting an External Relay with Line Power
The GPS360 can be used with an external relay in place of the internal one. If you are going to use an 
external relay, the GPS360 must be connected to line power, such as to the rectifier.     

 1. Connect the power cable to the interrupter. Line up the notch on the power cable to the 
connection on the interrupter. Twist ring on cable to lock the cable into the connection.         

Figure 4-1.   Power Cable and MicroMax Interrupter Connection

 2. Connect the external relay control or coil to the power cable OUTPUT. Be sure to observe 
proper polarity, especially if a flyback diode is present on a mercury relay coil.

Figure 4-2.   Power Cable Connections

 3. Connect the AC/DC Power Input cable to the power cable's INPUT connection.         
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Figure 4-3.   AC/DC Power Input Cable Connected to Twisted Wire Cable         

 4. Clip the AC/DC Power Input cable's alligator clips to the rectifier Coarse AC taps. Voltage 
range is 8-42 V AC.         

Figure 4-4.   Alligator Clips Connected to Rectifier Taps         

NOTE: If you are connecting to a DC power source such as a battery, the power requirement is 10-
60 V DC.       

Setting Display Contrast
Use the up  and down  arrow keys on the keypad to adjust the contrast level of the display. 
Press and hold the up arrow to increase the contrast; press and hold the down arrow to decrease the 
contrast.     

You can adjust the contrast level at any time except when the interrupter is running an interruption 
program.     
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Viewing GPS Info
With the main menu displaying, press 2 to display the GPS Info screen. Press PREV to return to the 
main menu.     

Figure 4-1.   GPS Info     

The GPS Info screen includes status information for the current number of satellites in view, time 
zone, antenna, and the current time and date.     

The following list describes the type of information shown on the GPS Info screen:     

 l GPS Info D 00:00:36 — The current time and date. The time is shown in military time (24 
hours) and uses the HH:MM:SS format to represent hours, minutes, and seconds. The date is 
shown in MM/DD/YYYY format to represent the month, day, and year. The letter shown just to 
the right of GPS Info is used to troubleshoot an issue with the unit's GPS lock.         

 l Ant: OK 00/00/00 — The antenna status. If the antenna is disconnected or loose, the status 
message Antenna OPEN displays. If the antenna is shorted, the status message Shorted 
displays.         

 l 3D Fix SV 07/07 — Shows whether a 2D or 3D GPS lock has been obtained and the number of 
satellites seen by the unit. In this example, 07/07 refers to 7 satellites in view out of 7 possible 
satellites. A 2D lock requires 3 satellites, while 3D lock requires at least 4 satellites. If the unit 
sees an insufficient number of satellites, move the antenna until at least a 2D lock (preferably a 
3D lock) is achieved.         
If no satellites are seen, the message Acq Sat appears in the display on the left side. The 
message 3D Fix displays when the unit has established communication with at least four 
satellites.         

 l UTC Setting: -06 — The Universal Time Constant (UTC) that is used by the GPS system.         

IMPORTANT: GPS lock is not needed for the GPS360 to operate. The internal clock updates as 
soon as the internal GPS locates satellites. For synchronized interruption or interference, make sure 
the antenna position enables at least a 2D lock.       
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Running a Test Program
Before programming the interrupter, you can test the interrupter by running a test program.     

With the main menu displaying, press  to display and begin the Test Mode. Press PREV to cancel 
the test or when the test is done.     

Figure 4-1.   Test Mode     

The following list describes the type of information shown on the Test Mode screen and that is used 
for the test:     

 l TEST MODE ON/OFF/DONE — The cycle that the interruption is running during the test. The 
test runs through an off and on sequence for a few seconds. It will then display DONE when it 
completes the test. The plug symbol  indicates that power is present.         

 l Switch: Norm Open — Shows whether the relay is normally open or normally closed. The 
setting is determined by the Switch setting in Out Parameters (refer to  Output Parameters on 
page 36).         

 l Synch — Shows that synchronization begins with On. The setting is determined by the Int. 
Cycle setting in Out Parameters (refer to Output Parameters on page 36).         

 l CYCLE 1s ON, .5s OFF — The timing of the on and off cycle.         
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Chapter 5: Interrupter Programming
The GPS300, GPS350, and GPS360 interrupters can be programmed either manually by using the 
unit's keypad or with the Bullhorn Tools configuration software. 

Refer to these topics for more information on programming your interrupter:

 l Configuring with Unit Keypad — using the interrupter's keypad to program the unit.                   

 l Configuring with Bullhorn Tools — using Bullhorn Tools to configure the interruption and 
interference programs.                

Status Icons
Table 1-1 defines the status icons shown on the MicroMax GPS300, GPS350, and GPS360 interrupters 
displays.     

Icon             Description             
 

 

3D — indicates that the GPS has a 3D fix on satellites.             

 

 

Arrows — use up  and down  arrow keys on the keypad to 
change the values of input fields. NOTE: the arrows can also be used 
to change the display contrast.             

 

 

Bars — indicates number of available satellites - more bars = more 
satellites.             

 

 

Carriage return — indicates user should press ENTER key on the 
keypad.             

 

 

Plug — indicates that AC or DC power is present.             

Table 5-1.  Status Icons       
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Icon             Description             
 

 

Wrench — indicates that user should press the Wrench key  on 
the keypad to make a change or run a test.             

 

 

Battery — GPS360 only; indicates the battery charge state. A full icon 
means that the battery is full. Refer to GPS360 Power and Battery 
Information on page 22for more information on using the built-in 
battery for interruption.        

 

 

Charging — GPS360 only; indicates that the battery is charging. This 
icon will be replaced by the battery icon when the battery has been 
fully charged. Refer to GPS360 Power and Battery Information on 
page 22 for more information on using the built-in battery for 
interruption.             

Table 5-1.  Status Icons        cont'd

Configuring with Unit Keypad
The MicroMax interrupters can be programmed through keypad menus and buttons. The following 
set-up tasks can be done from the keypad on the unit:     

 l Setting Up and Running an Interruption Program on page 31 — set up to nine different 
interruption programs.         

 l Setting Up an Interference Interruption Program on page 33 — set up or run an interference 
interruption program.         

 l Options Features on page 35 — set other features of the interrupters, including Output 
Parameters, Setting the UTC Offset, and Using Zero Crossing.         

Setting Up and Running an Interruption Program
Complete the following steps to set up and run an interruption program from the interrupter 
keypad:     

 1. With the main menu displaying, press 1 on the keypad.         

Figure 5-1.   Main Menus - GPS300 and GPS350 (L) and GPS360 (R)         
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The GPS360main menu includes an icon for the battery. When the battery is fully charged, the 
icon is solid. As battery power decreases, the icon changes to reflect current battery charge. 
When the battery is charging, the battery icon is replaced with a charging icon  . All other 
screens for the GPS360 are the same as for the GPS300 and GPS350.         

 2. Press any key from 1 to 9 to display the Interruption Program Setup screen for that program 
number.         

Figure 5-2.   Interruption Program Setup Screen         

The list below describes the type of information shown on the Programming Menu:         

 l # 5 On 12.0 Off 03.0: The program number. Press any number from 1 to 9 to view a 
saved program. The first line also shows the On and Off times of the interruption cycle.               

 l Start 06:00 01/01/14: The interruption schedule (Start/Stop) and the start time and 
date. For Daily, this line would also include the time set for the interruption to begin 
and end. For Continuous, this line would only display Continuous.               

 l Stop 18:00 12/31/99: For Start/Stop interruption only; the stop time and date.               

 l Change and Set: Use the Wrench  key ( ) to change the

                interruption schedule. Use the up  and down  arrow keys to change the values. 
Press ENTER ( ) to start the program.               

 3. Press  to change the interruption schedule. Available interruption schedules include:         

 l Continuous               

 l Daily               

 l Start / Stop               
For Start / Stop date, enter a date using the MM/DD/YY format to indicate the month, 
day, and year, such as 08/02/14.               

 4. To move from one field to another, press  or .        

 5. To enter a time such as 3.0 press the following keys on the keypad:         

 a. 3

 b. 0
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 6. To correct an entry while in a value field, enter the correct value over the current value. Press 
DEL to change the entry to 0.         

 7. Press ENTER to start the interruption program or PREV to cancel.         
When the interruption program begins, a screen similar to the following example displays. 
The screen displays while the interruption program is running.         

Figure 5-3.   Interruption Program Selected         

When the interruption program starts, you can either press 1 to view the Program Setup 
screen or 2 to monitor the GPS status. Press PREV to return to the Program Selected screen.         

 8. To stop the interruption program from running, press PREV and then ENTER to confirm. If 
ENTER is not pressed within a few seconds, the interrupter returns to the interruption 
program.         

NOTE: If the interrupter is powered off or loses power while executing an interruption program, it 
will automatically continue with the same interruption program once power is restored.       

Setting Up an Interference Interruption Program
The MicroMax interrupters include an interference mode that will synchronously interrupt specific 
groups of rectifiers to determine the influence of each rectifier on the structure under test. Also 
refer to Interrupter Overview on page 1 for more information on the interference mode interruption 
program.     

Complete the following steps to set up and run an interference program on a :     

 1. With the main menu displaying, press 3 on the keypad.         

Figure 5-1.   Interference Setup Screen         

The list below describes the type of information shown on the Interference Setup screen:         
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 l #10 On 13.0 Off 05.0: The program number and the on and off times of the 
interruption cycle.               

 l Delay: Delay time in seconds.               

 l Cycle Time 0088s: Indicates the total time of the cycle in seconds. This is a calculated 
value based on settings you enter for the on, off, and delay times as well as the total 
number of interrupters in the study.               

 l Unit #07/10 Next: : Shows this unit's number and the total number of units. Press the 
ENTER key to move to next screen.               

 2. To move from one field to another, press  or .         

 3. Enter new values as necessary using the keypad.         

 4. Press ENTER to move to the Interruption Program Setup screen.         

 5. Set up the interruption program. Refer to Setting Up and Running an Interruption Program on 
page 31 for instructions on setting up the interruption program.         

 6. Press ENTER to start the program.         
The interrupter will display a series of screens to begin the Interference program:         

NOTE: The GPS360 screen will display the battery icon along with the other status icons (refer 
to Status Icons on page 30).         

Figure 5-2.   Interference Waiting to Start         

Figure 5-3.   Interference Initializing Unit         
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Figure 5-4.   Interference Program Screen 1         

Figure 5-5.   Interference Program Screen 2         

The program then cycles through the set number of units shown at the bottom of the screen 
(For example, 10 as shown in this example). When finished, the program begins again.         

Figure 5-6.   Interference Program Screen 3         

 7. To cancel the program, press PREV. A cancellation confirmation screen displays.         

Figure 5-7.   Cancellation Confirmation Screen         

 8. Press ENTER to cancel and return to main menu. If you do not press ENTER within a few 
seconds, the program will continue.         

Options Features
Other features, such as setting output parameters, changing UTC offset, using zero crossing, and 
restoring factory defaults, are completed using the Options menu.     

To display the Options menu:     
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 1. With the main menu displaying, press 4 on the keypad to display the Options menu.         

Figure 5-1.   Options Menu         

 2. Complete any of the following steps:         

 a. To set output parameters, continue with Output Parameters on page 36.               

 b. To set the UTC offset, continue with Setting the UTC Offset on page 37.               

 c. To enable or disable zero crossing, continue with Using Zero Crossing on page 38.               

 d. To reset the interrupter to factory default settings, continue with Resetting to Factory 
Defaults with Keypad on page 38.               

Output Parameters

Output parameters are set to accommodate various current switch configurations and enable 
synchronization with other interrupters. Switch can be set to normally open (low output is off) or 
normally closed (low output is on). The default setting is Norm Open.     

Synchronization (Int. Cycle) can be set as OFF/ON or ON/OFF. The setting indicates which portion 
of the interruption cycle executes first on the synchronization event. The default setting is ON/OFF.     

Complete the following steps to set output parameters:     

 1. From the main menu, press 4 on the keypad to display the Options menu.         

Figure 5-1.   Options Menu         

 2. Press 5 on the keypad to display the Out Parameters screen.         
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Figure 5-2.   Output Parameters Screen         

 3. To move from one field to another, press  or  until the cursor is positioned on the field 
you want to change.         

 4. To change the field, press  until the desired output parameter displays in the selected field.         

 5. Press ENTER to save the setting or PREV to return to the Options menu.         

Setting the UTC Offset

The UTC (Universal Time) can be set from UTC –12 to UTC +12. The following table lists examples of 
typical time zones with corresponding UTC. The procedure following the table explains how to 
configure the interrupter with a UTC of your choice.     

Time Zone             UTC             
Eastern Standard Time             –05             
Central Standard Time             –06             
Mountain Standard Time             –07             
Pacific Standard Time             –08             
Eastern Daylight Time             –04             
Central Daylight Time             –05             
Mountain Daylight Time             –06             
Pacific Daylight Time             –07             

Table 5-1.  Time Zone and UTC Examples       

Complete the following steps to set the UTC:     

 1. From the main menu, press 4 on the keypad to display the Options menu.         

Figure 5-1.   Options Menu         

 2. Press 6 to display the UTC Offset screen:         
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Figure 5-2.   UTC Offset Screen         

 3. Press  or  to scroll through the UTC offset values.         

 4. Press ENTER to set the UTC value and return to Options menu.         

Using Zero Crossing

The MicroMax interrupters usually use a GPS reading to take timed measurements. Zero Crossing 
allows you to use the instant when the AC crosses zero instead of using a GPS reading.     

Complete the following steps to enable or disable Zero Crossing:     

 1. From the main menu, press 4 on the keypad to display the Options menu.         

Figure 5-1.   Options Menu         

 2. Press 7 to display the Zero Crossing Switching screen:         

Figure 5-2.   Zero Crossing Switching Screen         

 3. Press  to change the status of Zero Crossing from Enabled to Disabled or from Disable to 
Enabled.         

 4. Press ENTER to return to the Options menu.

Resetting to Factory Defaults with Keypad

Complete the following steps to reset the interrupter with factory default settings using the unit's 
keypad. Refer to Factory Defaults Settings on page 56 for a list of the factory default settings. The unit 
can also be reset to factory defaults by using tBullhorn Tools software. Refer to Resetting to Factory 
Defaults with Keypad on page 38 for more information.    
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 1. From the main menu, press 4 on the keypad to display the Options menu.         

Figure 5-1.   Options Menu         

 2. Press 8 to display the Factory Defaults screen:         

Figure 5-2.   Factory Defaults Screen         

 3. Press ENTER to reset the interrupter to factory settings or PREV to cancel.         

NOTE: Pressing ENTER replaces all current settings with factory default settings. You will need to 
reset the unit to any settings that are different than the defaults. After resetting the interrupter, the 
Options menu displays again. Press PREV to return to the main menu.       

Configuring with Bullhorn Tools
Bullhorn Tools is the configuration software that can be used to read and program a MicroMax 
interrupter. The software is available for download from the Bullhorn Tools launch site. 

The following topics detail how to use Bullhorn Tools configuration software to program the 
interrupter:

 l Installing Bullhorn Tools on page 40

 l Connecting Unit and Starting Bullhorn Tools on page 40

 l Configuring the Interrupter on page 41

 l Exiting Bullhorn Tools on page 54

http://install.bullhornsys.com/BullhornTools/
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Installing Bullhorn Tools

NOTE: Bullhorn Tools requires a minimum of 194MB of hard disk space.       

Complete the following steps to install  Bullhorn Tools:     

 1. From your browser, open the Bullhorn Tools launch page. 

 2. Click Launch.                The application will launch after installation. Once you have downloaded 
Bullhorn Tools from the launch website, all future updates will automatically be installed when 
you launch Bullhorn Tools on the computer it was installed on (with an Internet connection). 
You will not need to uninstall a previous version and then download a new version and install 
it.         

 3. If Bullhorn Tools does not launch automatically, click the Bullhorn Tools desktop icon  or 
click Windows  Start menu and select Bullhorn Tools.         

Connecting Unit and Starting Bullhorn Tools
Complete the following steps to begin the configuration process with Bullhorn Tools:     

 1. Connect the configuration cable to the USB port of your computer. Connect the other end of 
the cable to the USB CONFIG port on the unit.         

 2. Double-click the  Bullhorn Tools program icon on the desktop or open it from the Start 
menu.          

 3. Select the unit, and then click  Connect.       

http://install.bullhornsys.com/BullhornTools/
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Figure 5-1.   Connect to Unit         

Configuring the Interrupter
Use Bullhorn Tools to complete the following configuration tasks on the unit:     

 l Viewing Unit Information — the main Device Overview window displays current unit 
information, including Program settings, interruption settings, and battery data.         

 l Using Saved Templates — units can be configured from a previously-saved template that 
contains unit settings. Current unit settings are overwritten by the applied template.         

 l Setting Up Interruption Options — set interruption options, such as UTC Offset, Output Mode, 
Sync Mode, and Zero Crossing.         

 l Setting Up Interruption Programs — create up to nine different interruption programs.         

 l Setting Up an Interference Interruption Program — set up interference mode with interruption.         

 l Creating a Settings Template — unit settings can be saved to a template to save time when 
configuring multiple, identical units. Saved templates can be exported or deleted.         

 l Resetting to Factory Defaults with Bullhorn Tools — resets the unit to settings that were made 
during manufacturing.         

 l Upgrading Firmware — when available, the unit firmware can be upgraded. 
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Viewing Unit Information

Use the following steps to check unit and program information:     

 1. Click the name of the unit in the navigation pane to view Information, Firmware, Interruption 
Settings, and Power panes, as well as separate panes for each Program.         

Figure 5-1.   Bullhorn Tools Device Overview Window         

 2. Click  Refresh to read unit settings and verify the unit and Bullhorn Toolssoftware are 
communicating.         

Using Saved Templates

If a template is available for the unit type you plan to configure, you can apply the template to the 
current unit. You can also import a saved template to Bullhorn Tools and then apply it to the current 
unit.     
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For information on how to export or delete a saved template, refer to Exporting or Deleting Saved 
Templates on page 52.     

If a saved template is available to use, complete the steps described in one or both of the following 
sections:

 l Importing a Saved Template on page 50 — complete these steps first if the template is saved 
on your laptop or computer but has not yet been imported into Bullhorn Tools.                 

 l Applying a Saved Template on page 51 — complete these steps if a saved template is currently 
available to use from Bullhorn Tools.                 

Setting Up Interruption Options

Interruption options, such as UTC Offset, Output Mode, Sync Mode, and Zero Crossing, can be set up 
separately from the interruption programs.     

Complete the following steps to set up the interruption options on the MicroMax interrupters:     

 1. Click  Interruption.        

Figure 5-1.   Interruption Options         

 2. To change the UTC Offset, enter a value in the UTC Offset field. Refer to the following table 
for commonly-used time zones.         

Time Zone             UTC             
Eastern Standard Time             –05             
Central Standard Time             –06             

Table 5-1.  Time Zone and UTC Examples       
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Time Zone             UTC             
Mountain Standard Time             –07             
Pacific Standard Time             –08             
Eastern Daylight Time             –04             
Central Daylight Time             –05             
Mountain Daylight Time             –06             
Pacific Daylight Time             –07             

Table 5-1.  Time Zone and UTC Examples        cont'd

 1. To change the relay output mode, select either Normally Closed or Normally Open mode 
from the Output Mode drop-down list.         

 2. To change the synchronization, select either On/Off or Off/On from the Sync Mode drop-
down list.         

 3. The MicroMax interrupters usually use a GPS reading to take timed measurements. Zero 
Crossing allows you to use the instant when the AC crosses zero instead of using a GPS 
reading. To enable zero crossing for timed measurements, select Enabled from the Zero 
Crossing Mode drop-down list.         

 4. Click  Save to save settings or  Cancel to clear all fields.         

Setting Up Interruption Programs

The nine interruption programs can be set up from the main Bullhorn Tools window.     

Complete the following steps to set up Interruption Program 1 through Program 9:     
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 1. Click the program number; for example,  Program 1.         

Figure 5-1.   Program 1 Setup         

 2. Select an interruption schedule, such as Daily, Start/Stop, or Continuous, from the 
Interrupter Mode drop-down list.         

 3. If you selected Daily:         

Figure 5-2.   Daily Settings         

 a. Enter a start time in Start Time field. The time defaults to AM; change to PM by clicking 
on AM and then typing P.               

 b. Enter a stop time in Stop Time field. The time defaults to AM; change to PM by clicking 
on AM and then typing P.               
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 c. Enter a value (in seconds) in On Time field. Use the up and down arrows in the field to 
increase/decrease time by 0.1 seconds.               

 d. Enter a value (in seconds) in Off Time field. Use the up and down arrows in the field to 
increase/decrease time by 0.1 seconds.               

 4. If you selected Start/Stop:         

Figure 5-3.   Start/Stop Settings               

 a. Enter a start date in the Start Date field in the m/d/yyyy format. Or, click the arrow in 
the Start Date field and select a date from the calendar.               

Figure 5-4.   Start/Stop Date Calendar               

 b. Enter a stop date in the Stop Date field in the m/d/yyyy format. Or, click the arrow in 
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the Stop Date field and select a date from the calendar.               

 c. Enter a start time in Start Time field. The time defaults to AM; change to PM by clicking 
on AM and then typing P.               

 d. Enter a stop time in Stop Time field. The time defaults to AM; change to PM by clicking 
on AM and then typing P.               

 e. Enter a value (in seconds) in On Time field. Use the up and down arrows in the field to 
increase/decrease time by 0.1 seconds.               

 f. Enter a value (in seconds) in Off Time field. Use the up and down arrows in the field to 
increase/decrease time by 0.1 seconds.               

 5. If you selected Continuous:         

Figure 5-5.   Continuous Settings

 a. Enter a value, in seconds, in the On Time field. Use the up and down arrows in the field 
to increase/decrease time by 0.1 seconds.               

 b. Enter a value, in seconds, in the Off Time field. Use the up and down arrows tin the field 
to increase/decrease time by 0.1 seconds.               

 6. Click  Save to save settings or  Cancel to clear all fields.         

 7. Repeat these steps for each additional program.         

Setting Up an Interference Interruption Program

The GPS300, GPS350, and GPS360 include an interference mode that will synchronously interrupt 
specific groups of rectifiers to determine the influence of each rectifier on the structure under test. 
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Also refer to Interrupter Overview on page 1 for more information on the interference mode 
interruption program.     

Complete the following steps to set up an Interference program:     

 1. Click  Interference Mode.         

Figure 5-1.   Interference Mode         

 2. Select an interruption mode, such as Daily, Start/Stop, or Continuous from the Interrupter 
Mode drop-down list.         

 3. Enter a value, in seconds, in the On Time field. Use the up and down arrows in the field to 
increase/decrease time by 0.1 seconds.         

 4. Enter a value, in seconds, in the Off Time field. Use the up and down arrows tin the field to 
increase/decrease time by 0.1 seconds.         

 5. Select Enabled from the Interference Mode drop-down list.         

 6. Enter a value for the total number of units that will be a part of the interference cycle in the 
Number of Units field. Use the up and down arrows in the field to increase the value by 1.         

 7. Enter a value for this unit in the My Number field. Use the up and down arrows in the field to 
increase the value by 1.         

 8. Enter a value (in seconds) in the Delay field. Use the up and down arrows in the field to 
increase the value by 0.1 seconds.         

 9. Click  Save to save settings or  Cancel to clear all fields.         
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Creating a Settings Template

After configuring a unit, the settings can be saved in a template. You can use the template to set up 
another unit. The saved templates can also be exported to your computer or deleted.     

Complete the following steps to create a new template:     

 1. Click File > Create Template.         

 2. Enter a name for the new template.         

Figure 5-1.   Create Template         

 3. Click  Save to create a new template or  Cancel or X to cancel the process and close the 
window.         

Using Saved Templates

If a template is available for the unit type you plan to configure, you can apply the template to the 
current unit. You can also import a saved template to Bullhorn Tools and then apply it to the current 
unit.     

For information on how to export or delete a saved template, refer to Exporting or Deleting Saved 
Templates on page 52.     

If a saved template is available to use, complete the steps described in one or both of the following 
sections:

 l Importing a Saved Template on page 50 — complete these steps first if the template is saved 
on your laptop or computer but has not yet been imported into Bullhorn Tools.                 

 l Applying a Saved Template on page 51 — complete these steps if a saved template is currently 
available to use from Bullhorn Tools.                 
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Importing a Saved Template

 1. Click File > Template Management.         

Figure 5-1.   Template Management         

 2. Click Import to search for a saved template on your computer.         

 3. Navigate to the template, and click Open. The template now displays in the Select template 
list and will be available to apply.         

Figure 5-2.   Imported Template         

 4. Click Cancel or X to close the Template Management window.         
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Applying a Saved Template

 1. Click File > LoadTemplate.         

Figure 5-1.   Load Template         

 2. From the Apply Template window, select a template that has been previously saved in Bullhorn 
Tools from the list shown in the Select template drop-down menu.         

Figure 5-2.   Select Template         

 3. After selecting a saved template, a preview of the template settings will display in the Apply 
Template window.         
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Figure 5-3.   Template Settings         

 4. Verify unit settings, then click  Apply. The settings are applied to the unit.         

Exporting or Deleting Saved Templates

Saved templates can be exported to your computer or deleted from Bullhorn Tools.     

Complete the following steps to either export or delete a template from within Bullhorn Tools:     

 1. Click File > Template Management.         

 2. Select a template.         

Figure 5-1.   Template Management         
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 3. To export the template as a Bullhorn Template (.bht) file, click  Export. Select a destination 
for the file, and then click Save.         

 4. To delete the template, click Delete.         

 5. To close the window without any action, click Cancel or X.         

Resetting to Factory Defaults with Bullhorn Tools

The interrupter can be reset to the settings that were made at the time of manufacturing. If you reset 
to factory defaults, all current settings will be replaced with these default settings. Refer to Factory 
Defaults Settings on page 56 for a list of these settings. The unit can also be reset to factory defaults 
by using the unit's keyboard. Refer to Resetting to Factory Defaults with Keypad on page 38 for more 
information.

Complete the following steps to reset the interrupter with factory default settings using Bullhorn 
Tools software:     

 1. Click Action > Reset To Defaults.         

Figure 5-1.   Reset To Defaults         

A dialog box displays.         

Figure 5-2.   Reset To Defaults Confirmation         

 2. To confirm the reset, click  Reset. To cancel and close the window, click  Cancel or X.         



Interrupters User Guide

Chapter 5: Interrupter Programming 54

Upgrading Firmware

Available upgrades to the MicroMax interrupters firmware can be applied to the unit. Complete the 
following steps to upgrade firmware:     

NOTE: If the latest firmware is not available, the file can be downloaded from Bullhorn Web (Help 
> Downloads). Download the latest firmware upgrade before completing the steps in this section. 
Contact Technical Services (techservices@aiworldwide.com) for additional assistance.       

 1. Click Action > Upgrade Firmware.         

Figure 5-1.   Upgrade Firmware         

 2. Click Browse to search for the firmware file. This file should have the extension .bhf.

Figure 5-2.   Upgrade Firmware - Select File         

 3. Click  Send to install the new firmware, or  Cancel or X to cancel the upgrade process 
and close the window.         

Exiting Bullhorn Tools
Complete the following steps to close Bullhorn Tools:     

 1. Click File > Exit.         

 2. Disconnect the configuration cable from the unit and your computer.         

mailto:techservices@aiworldwide.com?subject=AI Technical Support
mailto:bhtechservices@aiworldwide.com
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The configuration is now complete.     
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Appendix A: Factory Defaults Settings
The following table identifies factory defaults settings for the MicroMax GPS300, GPS350, and 
GPS360 interrupters. 

To reset the unit's settings using the interrupter's keypad, refer to Resetting to Factory Defaults with 
Keypad on page 38. To reset the unit's settings using Bullhorn Tools, refer to Resetting to Factory 
Defaults with Bullhorn Tools on page 53.     

Setting             Value             
Interruption

              9 programs, Continuous, on/off times in 
seconds.             

Program 1: 3.0 / 1.0             

Program 2: 0.8 / 0.2             

Program 3: 3.0 / 1.0             

Program 4: 4.0 / 1.0             

Program 5: 12.0 / 3.0             

Program 6: 15.0 / 5.0             

Program 7: 0.7 / 0.3             

Program 8: 0.8 / 0.2             

Program 9: 9.0 / 3.0             
Interference

              On/off/delay times
              in seconds.             

On: 13.0s             

Off: 5.0s             

Delay: 2.0s             

Cycle time: 88s             

Unit #01/10             
Start Time             Immediate             
Stop Time             Never             
Output Parameters             Switch: Normally Closed             

Interruption Cycle: On/Off             
UTC Offset             UTC -06             
Zero Crossing             Disabled             

Table A-1.  MicroMax Interrupters Factory Defaults Settings       
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Appendix B: Technical Specifications
The following technical specifications cover the MicroMax interrupters. For additional specifications 
on load current, refer to Derating Tables on page 59.     

Specification             GPS300             GPS350             GPS360             
Input Power 10-60V DC or 8-42V 

AC             
10-60V DC or 8-42V 
AC             

10-60V DC or 8-42V 
AC             

GPS Synchronization Yes             Yes             Yes             
Interruption cycle Range: 0.1 - 999.9s

              Increments: 100 mS             
Range: 0.1 - 999.9s
              Increments: 100 mS             

Range: 0.1 - 999.9s
              Increments: 100 mS             

Auxiliary relay drive 
capacity

0.5 A             0.5 A             0.5 A             

Operating temperature -30 °C to +70 °C             

CD visible from -20 
°C to +60 °C             

-30 °C to +70 °C             

LCD visible from -20 
°C to +60 °C             

-30° C to +70° C             

LCD visible from -20 
°C to +60 °C             

Programmable 
schedules

9 programmable 
schedules
              start phase: on/off             

9 programmable 
schedules
              start phase: on/off             

9 programmable 
schedules
              start phase: on/off             

Display and enclosure LCD display
              fully waterproof case
              transparent cover             

LCD display
              fully waterproof case
              transparent cover             

LCD display
              fully waterproof case
              transparent cover             

Dimensions 6.0" x 4.5" x 2.8"             6.0" x 4.5" x 4" (with 
magnets attached)             

6.0" x 4.5" x 4" (with 
magnets attached)             

Weight 1 lbs. 11 oz. (0.77 kg)             3 lbs. 1 oz. (1.39 kg)             3 lbs. 1 oz. (1.39 kg)             

Integrated solid-state 
relay

N/A             Load current: Refer to  
Derating Tables on 
page 59.

Load voltage: 100 V 
Peak DC
              70 V Peak AC             

Type: Normally 
Closed, Solid State             

Load current: Refer to  
Derating Tables on 
page 59.

Load voltage: 100V 
peak DC
              70V peak AC             

Type: Normally 
Closed, Solid State             

Table B-1.  Interrupters Specifications       
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Specification             GPS300             GPS350             GPS360             
               Relay Options             Mercury Normally 

Closed (NC): 30 A, 60 
A and 100 A             

AC Solid State 
Normally Closed 
(NC): 80 A and 100 A             

DC Solid State 
Normally Closed 
(NC): 100 A             

Can be used with 
external relays             

Can be used with 
external relays             

Integrated battery N/A             N/A             Operating time: 60 
hours
              Charging time: 8 
hours (USB, 12V DC)
              Charging suspension 
temperature: -10 °C             

Table B-1.  Interrupters Specifications        cont'd



C

Interrupters User Guide 59

Appendix C: Derating Tables
Before setting up the GPS350, or GPS360 interrupter, consider the outside temperatures (both high 
and low) that the interrupter will be exposed to for the duration of your survey. For each 
temperature maximum, American Innovations recommends a maximum rectifier current for a given 
interruption cycle.     

The following tables identify the maximum rectifier current that is recommended when using the 
interrupter in the corresponding maximum outside air (ambient) temperature. Refer to these tables 
when setting up the GPS350, or GPS360 interrupter. 

 l GPS350 Derating Table on page 59

 l GPS360 Derating Table on page 59

GPS350 Derating Table
Before setting up the GPS350 interrupter, consider the outside temperatures (both high and low) 
that the interrupter will be exposed to for the duration of your survey. For each temperature 
maximum, American Innovations recommends a maximum rectifier current for the given 
interruption cycle.     

Ambient Temperature             Interruption Cycle             

Celsius Fahrenheit 0.8 s ON — 0.2 s OFF 4 s ON — 1 s OFF
25° 77° 60 A             80 A             
35° 95° 60 A             80 A             
45° 113° 58 A             78 A             
55° 131° 49 A             66 A             
65° 149° 38A             51 A             

Table C-1.  GPS350 Derating       

GPS360 Derating Table
Before setting up the GPS360 interrupter, consider the outside temperatures (both high and low) 
that the interrupter will be exposed to for the duration of your survey. For each temperature 
maximum, American Innovations recommends a maximum rectifier current.     



Interrupters User Guide

Appendix C: Derating Tables 60

Ambient Temperature             Maximum Current (A)             
Celsius Fahrenheit Setup 1 Setup 2
25° 77° 83             100             
35° 95° 76             100             
45° 113° 66             90             
55° 131° 56             80             
65° 149° 42             65             

Table C-1.  GPS360 Derating Table       

For Setup 1, the GPS360 can be in any orientation with the mounting magnets attached for easy 
installation.     

For Setup 2, the GPS360 mounting magnets have been removed, and the heatsink (the full back 
surface of the unit) is in full contact with the metal surface of the rectifier enclosure, or with another 
metal plate or box, to ensure good temperature regulation.     
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Appendix D: Mercury Relay Advisory
The information in this section is intended to notify American Innovations (AI) customers of the 
manufacturer's published limitations on mercury relays.     

Customers primarily purchase mercury relays for use with current interrupters. Current interrupters 
provide great programming flexibility to enable customers to use a wide variety of interruption 
cycles.     

AI supplies mercury relays from a variety of respected and reliable vendors including MDI and 
American Electronic Components (AEC). These manufacturers publish expected relay lives of 3 to 6 
million cycles depending upon the type of relay selected. AEC, the manufacturer of Durakool relays, 
indicates that relay life will be significantly shortened at rates exceeding 1,500 cycles per hour. MDI 
recommends no more than 900 cycles per hour. Depending upon the interruption cycle chosen by 
the customer, it is possible to exceed the manufacturer's recommendation, which would result in a 
likely reduction of service life.     

As an example, customers who elect to use mercury relays to interrupt at 1 cycle per second will 
generate 3600 cycles per hour. Customers should consult the manufacturer's documentation to 
select the appropriate relay for the application.     

Durakool information can be found on the AEC web page at the following address:     

http://www.aecsensors.com/html

In the Durakool documentation, the following two situations are explained that may impact the 
current carrying capacity of the relay: 1) cycle rate and 2) voltage values. The sizing tables indicate a 
methodology for determining the maximum amperage that can be carried depending upon the 
cycle rate. An additional derating table for mercury relays is provided for those instances where 
voltage in excess of 48 V DC is being interrupted. When selecting relays, customers should be aware 
of both of these derating tables to choose the best relay for the application.     

To avoid depolarization of the CP system, the mercury relays we sell that AI sells are of the normally 
closed variety. It is possible that a normally closed relay will fail at the end of its life in the open 
position due to a malfunction of the spring mechanism which drives the plunger/contacts into a 
normally closed position. If this occurs, a depolarization situation would result. AI has the following 
two recommendations:     

 1. Customers using mercury relays should consider periodic replacement of these relays based 
upon engineering estimated life via a preventive maintenance program to reduce the 
likelihood of an open circuit failure.         

http://www.aecsensors.com/html
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 2. If fast cycle operation is common, AI recommends a solid state relay for maximum life and 
reliability.         

Although most interrupters are capable of being programmed for faster interruption cycles, AI 
recommends that customers not exceed 900 cycles per hour (or a cycle time of less than four 
seconds) and will not warranty devices that are utilized in this manner. AI adds a serial number to 
relays that is supplied that we supply to enable the tracking of the shipment date. The approximate 
age of the relay may be used to assist AI in return material response, failure analysis, and warranty 
claims. Manufacturers will be consulted to help determine failure cause and to advise customers that 
warranties may not be honored if it is deemed that the mercury relay is used outside of 
recommended parameters.     

If you have any questions or need further assistance, give us a call at 1-800-229-3404 or email us at 
techservices@aiworldwide.com.

mailto:techservices@aiworldwide.com?subject=AI Technical Support
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Appendix E: Regulatory Notices
The following FCC requirements are met by the products described in this guide.     

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:     

 l Reorient or relocate the receiving antenna.         

 l Increase the separation between the equipment and receiver.         

 l Connect the equipment in an outlet on a circuit different from that to which the receiver is 
connected.         

 l Consult the dealer or an experienced radio/TV technician for help.         

Export Control Classification Number
The Export Control Classification Number (ECCN) assigned to the Bullhorn Tools software by the U.S. 
Bureau of Industry and Security (BIS) is as follows:     

 l ECCN Classification — No Classification         

 l ECCN Code — EAR99 or NLR         
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